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Communication is the act of conveying meanings from one entity or group to another through the 

use of mutually understood signs, symbols, and semiotic rules. 

*The following figure represents types of communication 

                                                                                                                                                   

     Learning objectives of Effective communication 

1. Development of Interpersonal Skills 

2. To express effectively & with maximum efficiency 

 

     

 

Every person has a unique communication style, a way in which they interact and exchange 

information with others. 

There are four basic communication styles: passive, aggressive, passive-aggressive and assertive. 

It’s important to understand each communication style, and why individuals use them. For example, 

the assertive communication style has been found to be most effective, because it incorporates the 

best aspects of all the other styles. 

 2.1 PASSIVE 

Individuals who use the passive communication style often act indifferently, yielding to others. Passive 

communicators usually fail to express their feelings or needs, allowing others to express themselves. 

Passive communicators often display a lack of eye contact, poor body posture. 

Examples of phrases that those who use a passive communication style would say or may believe 

include: 

          Class XI          Communication Skills 

1. What is Communication? 

2. The 4 Communication Styles 
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• “It really doesn’t matter that 

much.” 

• “I just want to keep the 

peace” 

2.2 Aggressive 

The aggressive communication style 

is emphasized by speaking in a loud 

and demanding voice, maintaining 

intense eye contact and dominating 

or controlling others by blaming, 

intimidating, criticizing, threatening 

or attacking them, among other 

traits.  

Aggressive communicators often issue commands, ask questions rudely and fail to listen to others. 

Examples of phrases that an aggressive communicator would use include: 

• “I’m right and you’re wrong.” 

• “I’ll get my way no matter what.” 

• “It’s all your fault.” 

2.3 Passive-Aggressive 

Passive-aggressive communication style users appear passive on the surface, but within he or she may 

feel powerless or stuck, building up a resentment that leads to seething or acting out in subtle, indirect 

or secret ways. 

Most passive-aggressive communicators will mutter to themselves rather than confront a person or 

issue. Passive-aggressive communicators are most likely to communicate with body language 

.Ultimately, passive-aggressive communicators are aware of their needs, but at times struggle to voice 

them. 

Examples of phrases that a passive-aggressive communicator would use include: 

• “That’s fine with me, but don’t be surprised if someone else gets mad.” 

• “Sure, we can do things your way” (then mutters to self that “your way” is stupid). 

2.4  Assertive 

Assertive communicators can express their own needs, desires, ideas and feelings, while also 

considering the needs of others. Assertive communicators aim for both sides to win in a situation, 

balancing one’s rights with the rights of others. 

Examples of phrases an assertive communicator would use include: 

• “We are equally entitled to express ourselves respectfully to one another.” 

• “I realize I have choices in my life, and I consider my options.” 

• “I respect the rights of others.” 
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Role play on different communication styles( ACTVITY) 

OBJECTIVE:  Have fun reflecting on our own communication styles, and consider which can be 

most effective in bringing our issues forward. 

   Role Play  

 Select a neighbourhood problem the group can relate to (Ex.  Garbage clean up) and practice 

a short role-play (2 – 3 min) to demonstrate three communication styles.  The players might 

be the two facilitators and a participant. The aggressive and passive people play the role to 

an extreme, so that it is so obvious that it is funny.  Their behaviour starts to change when 

the proactive person demonstrates a more constructive approach: 

AGGRESSIVE: (wears a very large yellow star) Walks into the scene very confident of his/her ideas, 

imposing them on everyone else. 

PASSIVE: (wears a very small yellow star) When expressing his/her ideas can hardly be heard, 

and allows the aggressive player to dominate. 

PROACTIVE: (wears a large yellow star) Steps into the scene after the other two have already 

demonstrated their styles.  He/She listens to the others, clarifies what they are saying, takes a 

few moments to consider what she/he is hearing and suggests some positive action for them to 

consider. (See Proactive in Styles of communication handout.) 

• Large group reflection (8 min) 

Ask:  “What happened?  What were the different ways of addressing the situation?” 

Note:  Keep the conversation focused on the communication style, not the issue. 

 



4 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Worksheet 

WHAT COMMUNICATION STYLE ARE YOU? 

Directions: Select the answer that describes how you communicate most often.P = Passive, AG = 

Aggressive, P/A = Passive Aggressive, and AS = Assertive 

1. My friends would call me 

  P :shy _________ 

  AG: loud__________ 

P/A: sarcastic_______ 

AS: confident _______ 

2. I usually: 

 P: don’t share my opinions even though I have them._______ 

AG: share my opinions in a demanding way._______ 

P/A: have opinions but don’t share them and then become angry towards everyone 

involved.________ 

AS: have opinions and share them with others while being open and respectful to the opinions of 

others. 

3. I feel: 

P: that the opinions of others matter more than my own.____________ 

AG: that my opinions matter more than the opinions of others.___________ 

P/A: that I will follow the opinions and ideas of others but talk badly about them behind their 

backs._____________ 

AS: that my needs are important and so are the needs of others._______________ 

4. When walking into a crowded room: 

P: I want to hide my face._______ 

AG: I don’t mind pushing my way through the crowd.__________ 

P/A: I may push someone out of my way and then blame it on someone else._________ 

AS: I smile and say “hi” to others and respect other people’s space.___________ 

5. I often: 

P: ignore problems.__________ 

AG: cause problems___________ 

P/A: hide problems._____________ 

AS: solve problems.____________ 
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Many people mistakenly confuse aggressiveness with assertiveness, which is not true. Aggressiveness 

is behaving in a hostile way. Assertiveness is standing up for your right to be treated fairly and/or 

advocating for yourself in a clear, direct, and honest way that is positive and proactive. It is expressing 

your opinions, needs,and feelings, without ignoring or hurting the opinions, needs, and feelings of 

others. Assertiveness is actually one of the most positive skill sets you can use and develop for lifelong 

success. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Worksheet 

Select the Assertive Communication method from the choices and see if you can identify the 

other methods of communication as your read through the choices. 

 In class: 

A. I’m too afraid to raise my hand even though I know the answer._________ 

B. I shout the answer because I always know them and no one else ever does. 

C. I know the answer but never participate and then get angry at other people who do. 

D. I raise my hand when I know the answer and give others the opportunity to do the same. 

 

2. You got a bad grade on a test and you’re not sure why. What do you do? 

A. You ask the teacher to talk after class. You respectfully explain your confusion about your grade 

and ask what you can do differently next time. 

B You don’t say anything but you talk badly about the teacher behind his/her back. 

C. You don’t say anything. It’s not a big deal. 

 

 3. Someone cuts in front of you in line… 

A. Say nothing, but glare at them and "accidentally" push them a little. 

B. Say nothing and do nothing. 

C. Assume they didn't know you were in line; gently explain that you waiting before them. 

D. Yell at them and shout for them to return to their place. 

 

a)There was a test in one of your classes on a day that you were absent. You were legitimately sick, 

but don’t have a doctor’s note. 

The teacher tells you that since you don’t have a note, you are not allowed to write the test which 

jeopardizes your entire credit. 

b) A friend wants to go watch a movie, however you want to go see something different. 
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3.1 What is Writing? 

Writing is a form of communication that allows students to put their feelings and ideas on paper, to 

organize their knowledge and beliefs into convincing arguments, and to convey meaning through well-

constructed text.                                    

3.2  Sentences 

The main focus here is to improve basic sentence composition skills. One can review the types of 

sentences and the functions of their component parts listed below. 

Simple, compound, and complex sentences 

3.2.1 Simple sentence 

 A simple sentence is one independent clause that has a subject and a verb and expresses a complete 

thought. 

• Must have a subject and a verb. 

• Must express a complete thought. 

• Must only have one clause. 

Examples 

• I am out of paper for the printer. 

• Will you help me with the math homework? 

3.2.2 Compound Sentence 

A compound sentence allows us to share a lot of information by combining two or more related 

thoughts into one sentence. It combines two independent clauses by using a conjunction like “and.” 

This creates sentences that are more useful than writing many sentences with separate thoughts. 

         Example of Compound Sentences 

     We use compound sentences all of the time. Here are some examples, the  independent clause is 

green, the second is purple, and the conjunctions are    orange: 

I drove to the office, and then I walked to the cabin.  

3.2.3 Complex sentence  

A complex sentence is a sentence that combines one independent clause with at least one dependent 

clause. 

 Example 

• Although Rohan had some doubts, he found the courses very useful. 

 https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson  

The link mentioned above will further will help the students to strengthen their concept on the 

above mentioned topics. 

 

    

3. Writing Skills 

https://study.com/academy/lesson/types-of-sentences-simple-compound-complex.html#lesson
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A worksheet can be taken up in the class to test the concept clarity. 

 

 

 

 

Activity 

 

This activity simulates ‘chatting’ – a popular (online) communication  can be used in the language-

learning classroom for students who still find it too difficult to write without first having a little 

‘thinking’ time, and also as a means of moving students away from being overly concerned with 

accuracy, and focussing more on successful communication. The students really enjoy this activity, 

especially the fact of being ‘allowed’ to write notes in the class. 

The students will need one piece of paper for writing on simple sentences. To encourage students 

to write brief messages each time, this could be in the form of a ‘chatting page.( The activity will be 

done in pairs) 

                                                        Chat sheet 

Student A     

Student B  

Student A  

Student B  

  

  

   A suitable subject for the students to ‘chat’ about  is choosen such as: ‘Discuss your favourite 

sports’. Subjects requiring students to reach a solution are particularly effective, for example: 

‘Arrange to meet up a client at the weekend and decide what you are going  to build up business. 

• It will be explained to students that in order to communicate, they write a message on 

the first line of their paper, say ‘Hi, how are you?’, and ‘send’ it over their shoulder to 

their partner, who will respond and pass the paper back as quickly as possible. 
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Worksheet 

 
   Choose your answers to the questions for the above set of questions. 
  Q1. Do as directed 

a) How many clauses appear in the sentence below? 
     When he woke up that morning, Joseph wondered about his chances at getting the job, but he shrugged off 
any doubts. 
  i)Two 
  ii)Three 
  iii)One 
  iv)Five 
 v)Four 
b)Which of the following sentences has an INCORRECT subject-verb agreement? 

i)Subject-verb agreement usually gets trickier as sentences expand into more complex structures. 
ii)It's amazing that there are never any leftovers in my house after the Super Bowl game. 
iii)The thought of all the home repairs we need after the bathrooms flooded are daunting. 
iv)Any book about space visits from vampire Martian aliens is my idea of a good weekend read. 

b) Which of the following pronouns must ALWAYS be paired with a plural verb? 
 

i)Few, many, both, others, and several. 
ii) Most, any, none, some, and all. 
iii) Politics, gymnastics, mathematics, and news. 
iv) Whomever, whichever, they, and themselves. 
Silence is golden when you can't think of a good answer.' - Muhammad Ali 
 

c) In this famous quote, which choice best describes the second part of the sentence 'when you can't 
think of a good answer?' 

i)Compound sentence 
ii) Simple sentence 
 iii)Dependent clause 
iv)Complex sentence 
 v) Independent clause 

    e) What is wrong with the following sentence? 
 
    Clint didn't talk much he just stared you down with cold, dead eyes. 
 i) It has a comma splice. 
 
  
ii) It is a sentence fragment. 
 
  
iii) It is a regular run-on sentence. 
 
  
'iv) He' should be capitalized. 
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 3.3 Phrases - Phrases are a group of words that work together to communicate an element of 

speech. 

                                                                

 3.4 Types of phrases   

3.4.1.Noun Phrase 

A noun phrase is any noun or pronoun along with its modifiers: 

Example –  

• The school children 

• Yesterday’s newspaper 

3.4.2. Verb Phrase 

A verb phrase is any number of verbs working together: 

       Example 

• Had been sleeping 

• Will contact 

• May have written 

 

3.4.3. Prepositional Phrase 

1. A prepositional phrase always starts with a preposition and ends with a noun or pronoun 

(and its modifiers) that is called the object of the preposition: 

        Example 

• Through the wheat field 

• Preposition: through 

• Object of the preposition: the wheat field 
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   Some more examples of prepositional phrases: 

• During the year 

• Despite complaints 

3.4.4. Verbal Phrases :There are three types of verbal phrases: participial phrases, gerund phrases, 

and infinitive phrases. Each is explained below. 

a) Participial Phrase 

Participial phrases start with either a present or past participle. Here are some examples of each. 

Phrase with present participles: 

• Watching silently 

Phrases with past participles: 

• Driven to succeed 

 

b) Gerund Phrase 

A gerund phrase is a present participle (and its modifiers) that acts like a noun. It can take on 

a variety of jobs in the sentence. Here are a couple of examples: 

• Practicing helped a lot. (subject) 

• I love reading. (direct object) 

 

c) Infinitive Phrase 

An infinitive phrase is the infinitive and its modifiers: 

Example 

• To sing 

• To walk all that way 

 

d) Appositive Phrase 

An appositive phrase is a phrase that renames an earlier noun or pronoun 

My best friend, Nick Palacio, loves scuba diving. 

We watched Sirius, the brightest star in the sky 

e) Absolute Phrase 

Absolute phrases are the trickiest to identify. These phrases are not closely connected to the 

rest of the sentence; they don’t describe a specific word, but modify the whole sentence. They 

add extra information and are usually separated by commas (or dashes).  

Example 

The semester finished, Karen sold all her textbooks. 

           Absolute phrase: The semester finished 

          A worksheet can be taken up in the class to further built up the concept 
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Worksheet 

 

 
 
             For each sentence, Identify the phrase in bold font. 
  
 
1.I wish the university that I attend would have an annual kite flying festival in spring time. 
 
2. I am pretty sure I have been told that I'm a good listener. 
 
3.My hero, the man in the moon, has not yet delivered a TED talk. 
    
 4.She sang a traditional song called "Over the Hills and Far Away." 
    
 5.Its all spread by word of mouth. 
   
6. The Bill Gates Foundation does much charitable work. 
 
7.Bungee jumping is not a sport that I would try, since it does not seem entirely safe to me. 
 
8. Our lawyer, William Weary, takes care of all of our speeding tickets, but his bills end up costing 
just as much. 
  
9.To marry him was out of the question. 
   
10.Dreaming away, Tristan did not notice that the lights had changed. 
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   3.5 Parts of a Sentence 

     Every sentence can be broken into two parts  

a) Complete Subject 

b) Complete Predicate 

• The complete subject consists of simple subject ( The noun or the pronoun is the subject 

is about) and its modifiers 

• The complete predicate is made of up of verb and its modifiers. 

                                 

Activity 

Writing skills (Consumer power) 

  We are all to some extent consumers, so this is a subject that students of all nationalities and 

ages should be able to identify with. 

  

 
Activity – Mare’s nest 

 A hypothetical situation will be given to students related to present day scenario and they are 

asked to present(write) the views on the same. The following activity will help them to identify 

and find a solution the present day Consumerism related issues . 

(Example) 

You have a favourite brand of trainers that you love. You have asked your parents for a pair of 

these trainers for you birthday present. Last night you saw a documentary on the TV that 

showed where this brand of trainers are made and you saw that they are made in huge factories 

by children who have to work 14 hours per day and are treated badly. What do you do? Do you 

still want a pair of these trainers for your birthday? 
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The subject of a complete sentence is who or what the sentence is about, and the predicate tells about 

that subject. 

Yesterday after lunch the students were complaining about the short recess.  

The students” are the subject (red) of the sentence. The predicate always includes the verb, and tells 

something about the subject; in this example, the students ( purple)“were complaining about the 

short recess.” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activity - Writing skills 

Here we will explore the theme of social media. Students will create an imaginary online 'wall' where 

they can interact with each other. 

Making on social networking profile 

               (Basic information) 

Name  

Age  

Gender  

Location  

Hometown  

Interested in( Hobbies)  

 Strengths  

Why I am here 
( few lines) 

 

Personality( Introvert/ Extrovert)  

 Self Introduction  

 

   This activity will help the students to make contacts, communicate and express themselves better . 
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3.6 Parts of speech-  A category to which a word is assigned in accordance with its syntactic 

functions. In English the main parts of speech are noun, pronoun, adjective, determiner, verb, 

adverb, preposition, conjunction, and interjection. 

The following figure represents eight parts of speech 

                                           

 

3.6.1.  NOUN- A noun is the name of a person, place, thing, or idea.London,Flower,Happiness 

3.6.2. .PRONOUN- A pronoun is a word used in place of a noun.She, we,they, it 

 3.6.3. VERB- A verb expresses action or being. Jump ,is 

3.6.4. ADJECTIVE -An adjective modifies or describes a noun or pronoun. Pretty,old 

 3.6.5. ADVERB -An adverb modifies or describes a verb, an adjective, or another adverb. Gently, 

extremely 

3.6.6. PREPOSITION -a preposition is a word placed before a noun or pronoun to form a phrase 

modifying another word in the sentence. 

By,with, 

3.6.7.  CONJUNCTION -A conjunction joins words, phrases, or clauses. T 

The young girl brought me a very long letter from the teacher, and then she quickly disappeared. 

3.6.8. INTERJECTION - An interjection is a word used to express emotion. Oh! ,Wow! 

The following link will help to reinforce the concept 

(https://www.youtube.com/watch?v=v9fCKTwytJA) 

 

 

 

 

 

https://www.youtube.com/watch?v=v9fCKTwytJA
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 Persuasion skills are an important tool for employees in every industry. The ability to influence others, 

present effective arguments and prompt others to act is a valuable asset that can be beneficial in a 

range of workplaces. 

 Persuasion is the process of convincing someone else to carry out an action or agree with an idea. In 

the workplace, persuasion is used to sell products, recruit team members and increase productivity. 

An employee with strong persuasion skills can influence others to perform well and succeed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Writing skill) 

Activity -Embrace a word 

Students will be given templates with a heading 

Word Meaning Part of speech Example of usage 

    

• The students choose a word that they would like to adopt and do some research on it 

using the template above. 

• Each student then gives a short presentation on his or her adopted word until all the class 

has had a chance. 

• The words are then stuck to a large paper chart on the wall 

 This activity will help the students to streamline their thoughts and build up their vocabulary. 

 

4. Persuasion Skills 

Activity- Snakes and ladder 

Purpose 

In this team building exercise, students work together to complete a task. It requires concentration, 

planning and fast execution. Here, the decisions made by one team can affect the performance of 

another so planning has to be dynamic as the changing environment. This exercise is ideal to train 

people on quick decision making, leadership, persuasion skills and team work. 
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Activity 

This exercise helps students to brainstorm how to cross sell products. It focuses on a random set of 

products so it is rather creative to see what marketing strategies students can come up with. The key 

point to make in this exercise is that any two products can be related to each other and this can be used 

as material for marketing and cross selling. 

Objective 

Cross sell a pair of products while thinking of marketing strategy and advertisement approach. 

What You Need 

Small blank cards. 

Setup 

• Make the cards available to all students. 

• Explain that in this exercise, students will get to learn how to cross sell. 

• First they would need to select a number of products. If the delegates are from the same 

organisation, they should select their own products. If not, they can select any product though you 

can choose to limit the set to bias the exercise based on your training needs. 

• Ask the students to pick around 20 products together. For example, if you have 8 delegates, each 

delegate should pick three cards and write the name of one product on each. The teacher will end 

up with 24 products in this case. 

• Allow one minute for this. 

• Collect all the cards and check for duplicates. Ask the students to add more products if needed. 

• Keep the pile of cards (master pile). 

• Now, give one card to each student. Ask students to pair up with another person at random. If you 

have an odd number of students use a group of three. 

• Ask the groups to relate their products with an aim to cross sell them. How would they market the 

products together? How can one product be used to support the sale of the other? What 

advertisement strategies would they employ? 

Allow 15 minutes for this part. 

• Collect half the cards and put them aside. 

• Give a fresh card from your master pile to each person who doesn’t currently have a card. 

• Now ask the students to repeat the exercise. Encourage students to talk to a different person than 

they did in the first round. 

• Ask students their experiences one by one and explain what was most interesting about what they 

went through in this exercise? 

Allocate about 15 minutes for this part. 

• Follow with a discussion to wrap up a number of grand conclusions or actions. 

• Timing 

• Explaining the Exercise: 2 minutes 

Activity: 3 min selecting a unique set of products + (15 min cross selling * n rounds) + 15 minutes sharing 

experiences = 48 minutes for two rounds 

Group Feedback: 5 minutes 
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Summary :  

A classroom environment relies heavily on the quality of communication taking place within it. As an 

instructor, taking steps towards improving the communication skills of your students will contribute 

positively towards your classroom climate. Students with effective communication skills will be more 

likely to contribute to class discussions, will be more productive members in group projects, and will 

ultimately gain more from their experience in  the class. Learning and practicing writing skills help 

students to handle professional and social tensions.  
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The basic and important aspect of self - management is physical appearance, grooming, mannerisms 

and etiquettes of a person. This creates first image in the mind of people about others. 

 

 

 

Impressive appearance and well-groomed behaviour reflect our preparedness to handle the world 

around us. God has blessed us with this beautiful life and our body. It is our utmost responsibility to 

respect the almighty by keeping and presenting our body in best of shape. It all starts with oneself. 

You give respect and care to yourself; others will also give importance to you. Let’s look at the meaning 

of impressive appearance and grooming. Impressive appearance means having the ability to impress 

the mind, arousing admiration, awe, respect for the way someone looks or carries oneself. Grooming 

refers to the things people do to keep themselves neat and presentable. Proper grooming and 

impressive appearance are important to gain not just positive impression but also respect in the 

society. 

1.1. Importance of dressing appropriately, looking decent and positive body language 
Dressing appropriately, looking decent 

and positive body language all create a 

positive first impression. Dressing 

appropriately reflects the role that one 

plays. As a student studying in school, one 

is supposed to wear neat and ironed 

school uniform. Same uniform will be 

inappropriate if worn in a party or during 

family picnic or in swimming pool. When 

one dresses appropriately and keeps oneself neat, he/she conforms to generally acceptable standards 

of respectable and decent looks. Looks, gestures and postures comprise body language. A positive 

body language uses respectful, decent, non-offensive and appropriate expressions and body 

movements. 

Following points highlight the importance of dressing appropriately, looking decent and positive 

body language. 

• Promotes self-respect 

• Boosts self-confidence 

• It’s a step to overall improvement 

• It shows your attention to detail 

• Every expression leaves an impression 

• Your attire speaks before your words 

• Draws the right kind of attention and sends the right message 

 

       Class XI               Self-Management Skills  

1. Impressive Appearance and Grooming 
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1.2 Personal grooming checklist 
We have already seen the importance of well-groomed individuals. Following is the personal 

grooming checklist that you should strictly follow. 

• Maintaining health by seeing a doctor when necessary. 

• Maintaining health by eating well-balanced diet. 

• Maintaining health by using good posture. 

• Bathing or shower every day. 

• Shampooing the hair regularly. 

• Styling hair in a neat (away from my face and off my collar) manner. 

• Brushing teeth regularly (at least twice daily). 

• Trimming fingernails and keeping them clean. 

• Wearing properly fitted clothes. 

• Donning clean and ironed  clothes. 

• Changing socks and stockings daily to reduce foot odour. 

• Avoiding wearing jewelry or perfume with uniform. 

 

 

 

Every now and then we examine and analyze the goals we want to 

achieve in life and the necessary resources we need to realize them. Self- 

exploration refers to knowing one’s potential by examining and analyzing 

intellectual and spiritual capacities. Self-exploration helps develop a clear 

understanding of self-interests, attitudes, skills, wants and needs, which 

guide you to choose your profession for life. It also helps in identifying 

the goal of life that we wish to pursue. Self-exploration journey is as 

beautiful as its destination. Following approaches may help people self- 

explore.  

• Learning  

Formal / Informal/ Self-directed learning leads to acquiring some skills. Out of the learnt skills 

some skills may be preferred skills, and may guide us shape our career. An attitude of 

continuous learning helps us to update ourselves with the required skill set that keeps changing 

with the time. 

• Career Counsellor / computerized career information systems 

Career counsellor and career information systems can help one with information on courses and 

the outcome of the courses. 

• Self-reflection/ Inquiry 

This is a thoughtful process where people discover themselves through reflection on past 

experiences and patterns of their own behaviour.  

• Feedback 

Peers, family and mentors provide us with genuine feedback which help us identify our hidden 

talents and strengths.  

 

 

2. Self-Exploration Techniques 
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Team refers to a group of people who have complementary skills and work towards a common goal. 

Common examples around us are of cricket team, volleyball team, team of doctors and nurses. Teams 

result in higher productivity. Teams are very useful in performing work that is complicated, complex, 

interrelated, and /or more voluminous than one person can handle.  

 3.1 Important factors that influence team building 
Following are the factors which influence team building:  

• Work Team Structure 

It includes goals and objectives, operating guidelines, 

performance measures, and role specification. 

• Work Team Process 

Work team competitiveness and cooperative behaviour 

need to be considered while building a team. 

• Diversity 

Diversity influences team building as well as effectiveness. 

Diversity shall be ensured in gender, background and 

competencies. Diverse team also ensures creativity. 

3.2 Factors influencing team work 
Following factors may influence team work. 

• Team norms 

Team norms is the standards or rules that govern the performance of the group members. These 

rules can be written or unwritten.  

• Team cohesion 

Bonding between the group members will come easily and together they contribute to the 

larger goal. 

• Social loafing 

Social loafing or free riding occurs when one or more group members rely on the efforts of other 

group members and fail to contribute their time and effort. Identifying individual contribution 

can help nullify the effect of free riding. 

• Loss of individuality 

It is a social process in which individual group members lose self-awareness and its 

accompanying sense of accountability, inhibition and responsibility for individual behaviour.  

 

 

 

Time management is the process of planning and exercising control of time spent on various 

activities to increase efficiency and effectiveness. Time as a resource is the same for everyone. It is 

up-to us to make the best use of this resource.   

Following are  the set of activities we need to take up for time management 

• Setting and prioritizing goals 

We have option to steer our life or to let it run on its own. If we take charge of our life and our 

goals, we will be able to lead a meaningful life. For leading a successful life, we should create our 

targets and aims. This can only be achieved if we are able to set and prioritize our daily activities, 

which shall be aligned to our goals. 

3. Team Work Skills 

4. Time Management Strategies and Techniques 
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• Creating a schedule 

Creating a schedule instills discipline and punctuality and ensure efficient utilization of our time. 

• Making lists of tasks 

This should be our first to-do thing every morning. List of tasks shall be prioritized for making our 

day worthwhile.  

• Balancing work and leisure 

Work is important and equally important is leisure activity to help us unwind and recharge for the 

important tasks. 

• Breaking large tasks into smaller tasks 

We should break large tasks into smaller ones. Smaller tasks can be finished in lesser time. When 

we will finish few small tasks, we feel motivated to complete others too. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Lets’ Do It !! 

Activities 

Session A. Demonstration of impressive appearance and groomed personality 

Session B. Demonstration of the ability to self-explore with the techniques mentioned. 

Session C. Group discussion on qualities of a good team and on strategies that are adopted for team 

building and team work 

Session D. Game on time management with checklist and to-do-list preparation on a given day. 

 

 

A 1,A2,A3,A4 
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1.1 INTRODUCTION TO WORD PROCESSING 
 
A word processor is a software that helps you type and work with text on a computer. You can create 
a document like, letter, memo, newsletter and save it in word processor. The main advantage of 
creating a document is word processor is that a document can always be opened and edited. You can 
also format it, check and correct spellings and grammatical errors in it, insert drawings, images, and 
pictures, apply page borders, and also print it. 

 
1.2 SOFTWARE PACKAGES FOR WORD PROCESSING 
 
A variety of word processors such as Microsoft Word, Open Office Writer, and Star Office have been 
developed to make text input and editing on the computer easy. An online word-processing 
application such as Google Docs (part of Google Drive), is also becoming popular. 
 
Let us learn about Apache Open Office Writer,  
a popular Open source word processor.  
 

1.2.1 Apache OpenOffice  
 
Apache OpenOffice is a free and open-source software that has been developed by the Apache 
Software Foundation. Apache OpenOffice can be downloaded for free from:  
 
http://www.openoffice.org/  
 
It is available in a number of languages. It can also read/write files created in other Office software 
packages.  
 
The Apache OpenOffice package contains the following: 
• OpenOffice Writer (Word processor) 
• OpenOffice Calc (Spreadsheet) 
• OpenOffice Impress (Presentation) 
• OpenOffice Base (Database Management System) 
• OpenOffice Draw (Graphics) 
• OpenOffice Math (Equation Editor) 
 
In this chapter we are discussing version 4.1.5 of Apache OpenOffice. You regularly get updated 
versions of OpenOffice. The new version of Apache OpenOffice shows a sidebar on the interface of 
Writer, Impress, and Calc. It is similar to the ribbon in Microsoft Office.  

 

 

 

 

Do you Know? 

Word Processor was the first most 

popular Word processing software. 

     Class XI                                   ICT Skills 

            Unit 1. Creating A Document In Word Processor 
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1.3 OPENING AND EXITING WORD PROCESSOR 
 
Apache OpenOffice Writer is a word processor program, which is equivalent to MS Word. It is used 
for creating, editing, formatting, and printing text documents. You can include pictures, charts, tables, 
and can save the document in various formats.  
 
To start OpenOffice Writer, click Start ➢ All Programs ➢ OpenOffice 4.1.5 ➢ OpenOffice Writer. 
The Apache OpenOffice Writer window, along with its sidebar and other components, is shown in 
Figure 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                                                           Fig. 1 Apache OpenOffice Writer window 
 
Title Bar  The title bar is placed at the top of the Writer window. It displays the currently opened 
document name followed by the program name. If you create a new document, it shows the name as 
Untitled 1, Untitled 2, etc. This is replaced by the filename you give when you save the document. To 
the right of the title bar, you can see three buttons: Minimize, Restore Down/Maximize and Close. 
The Minimize button is used to reduce the window to a small icon on the taskbar. The Restore Down 
button is used to make the window smaller than full size. The same button is used to bring it back to 
full size. The Close button is used to close the window. 
 
Menu bar The Menu bar, which is displayed below the Title bar, has different options like, File, Edit, 
View, etc.. Clicking on a menu option displays options of this menu. 
 
Standard Toolbar It is displayed below the Menu bar and contains buttons for the most commonly 
used commands, like, New, Open, Save, etc. 
 
Formatting toolbar This toolbar has buttons for the most commonly used formatting commands. 
 

Title bar 
Standard bar 

Formatting 

bar 

Vertical 

ruler 

Status bar 

Zoom control 

Minimize 
Maximize/Restore 

Down 

Close 

Side bar 
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Document Window The document window is used to create a document. This is the area where you 
can type text, insert pictures, etc. 
 
Scroll bars  The horizontal scroll bar is present at the bottom of the document window and is used to 
move the document left or right. The vertical scroll bar is present to the right of the document window 
and is used to move the document up and down. 
 
Rulers The horizontal ruler is present at the top of the document window and is used to set left and 
right margins. The vertical ruler is present to the right of the document window and is used to set top 
and bottom margins. 
 
Status bar The Status bar is present at the bottom of the Writer window. It displays information about 
the current document, such as number of pages, current page number, etc. 
 
Zoom control The zoom level of the document can be set by clicking, holding, and dragging the slider. 

  

 

 

 

 

 
1.3.1 Opening a Document 
To open an already saved document in OpenOffice Writer: 

1. Click the Open option from the File menu. 
                     Or 
           Click the Open (Fig 2) button on the Standard bar. 
 

 
Or 

 
Press Ctrl + O. 
2. The Open dialog box appears. 
3. Select the Drive and the folder. 
4. Select the file and click Open button. 

 
1.3.2 Closing a Document 
To close an open document, click the Close option from the File menu. 

 
1.3.3 Exit Writer 
To exit Writer, click the Exit option from the File menu. 
 

 
1.4 CREATING A NEW DOCUMENT 
To create a new text document in OpenOffice Writer: 

1.  Select File  ➢New ➢ Text Document. (Fig 3) 
 

Or 
 
Click New button                   on the Standard toolbar  

Open button 

Fig 2 Open button on Standard bar 

 

Lets Try It 

Start OpenOffice Writer. Identify various components of the OpenOffice Writer window: - Title bar, Standard 
bar, Formatting bar, Horizontal and vertical scroll bar, Horizontal and vertical ruler, Minimize, maximize and 
Close buttons, Status bar 
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and select the desired option to create a new text  
document. 
 
Or 
 
You can also press Ctrl + N on the keyboard to create a new document. 

 
1.5 SAVING A DOCUMENT 
To save a document,  

1. Click the File menu. 
2. Select Save As option . (Fig 4) 

 
             Or 
 
  Click the Save button                on the Standard bar. 
 

3. The Save As dialog box appears. (Fig  5) 
4. Select the location where you want to save  

the document. 
5. Type the file name, and click on the Save  

button. Documents created and saved in  
Writer have the extension .odt by default. 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Keyboard Shortcut 

Save   Ctrl +S 

Save As  Shift + Ctrl + S 

 

   Fig 4 Save AS option of File menu 
 

 

            Fig  5 Save As dialog box 

Fig 3   New option of File menu 
 

Let’s Try It 
 
Teacher can discuss with the students about earlier Typewriter which was used for typing. But there 
were some limitations of using a typewriter. Discuss the limitations and ask the students to create a 
document and type these limitations. Also, the teacher can discuss about electronic typewriters, 
which used to print one line of typing at a time. 
 

1. Start OpenOffice Writer. 
2. Create a new document. 
3. Type a paragraph about limitations of using typewriter. A sample is given below: 

 
 
 
 
 
 
 
 

4. Save the document with name ‘typing’. 
5. Close OpenOffice Writer. 

 
 

Limitations of Using Typewriter 

If there was some error while typing using typewriter, correction could not be done and entire 

sheet had to be typed again. Also, if same document or letter was to be send to different persons, 

then it had to be typed again and again. The formatting of the text was also not possible when 

document was typed using typewriter. 



28 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Let’s Try It 
 
Now, discuss the advantages of using word processor, and ask the students to perform the following 
task on computer.  
 

1. Start OpenOffice Writer. 
2. Open the already saved document ‘typing’. 
3. Now add another paragraph about advantages of using word processor. 
 
 
 
 
 
 
 
 
 
 
 
4. Save the document. Which option will you select to save the file with the same name –Save 

or Save As? 
5. Close the document. 
6. Exit from Writer. 

 
 

Advantages of Word processor 

The document created on computer using word processor can be saved and edited. The document 
remains saved until we delete it. The text can be formatted to enhance its appearance, like, you can 
change the font, size and color of the text. You can also highlight important words. If there is some 
error, the document need not be typed again, corrections can be done in the same document. You 
can also check the spelling and grammatical mistakes. The document can be printed. You can insert 
pictures and graphs in a document. You can insert different shapes, etc. 
 

Let’s Try It 
 

1. Create a new document in Writer. 
2. Type a paragraph mentioning use of word processor for students, teachers, in business, etc. 

Hint: You can mention that students can do assignments, type project reports in word processor. 
Teachers can prepare assignments, question papers, etc. In offices, word processor can be used 
for preparing reports, writing letters, etc. 

3. Save the document as ‘word processor’. 
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Worksheet 1 
 

1. Name the two toolbars.  ____________  ________________  
2. Name the toolbar used to scroll the document up and down ________  
3. Name the bar present at the bottom of the Writer window that gives information about the number 

of pages in the document. __________  
4. Name the two rulers ____________  ______________  
5. Name the ruler that is used to set the left and right margins __________  
6. Name the bar that has buttons for the most commonly used commands ______   
7. Name the three buttons present to the right of the Title bar. ______  
8. Name the button used to reduce the window to a small icon on the taskbar. _____________  
9. Which button is used to make the window smaller than full size? ___________  
10.  Mention any two features of word processors. 

____________________________________________________________________________ 
 
____________________________________________________________________________ 

 
 Worksheet 2 

1. Dhruv has to type his project report. Name the software he can use for this purpose. 

2. Hiren has created a new document in Word processor. In which part of the word processor 

window, name of the document is displayed? 

3. Udhav wants to reduce the window size to a small icon on the taskbar, which button should he click 

– Maximize, Minimize, or Close? 

4. Which toolbar – Standard or Formatting contains the buttons for commands like, New, Save, Open, 

etc.? 

5. Piyush wants to check the number of pages in the document. Name the bar that displays this 

information. 

6. Riya has to check left and right margins. Which ruler- Horizontal or Vertical should she check? 

7. Mudit noticed “Page 1/2  “ displayed on the left of the Status bar. What do numbers 1 and 2 

represent? 

8. Name the three buttons present to the right of the Title bar. 

9. Gurpreet’s teacher told her that there are two scroll bars in Word Processor window. Name the 

scrollbar present at the bottom of the document window. 

10. Name any one online word processor. 

 

Worksheet 3 
 

1. Write Keyboard shortcuts for the following commands: 
a. New 
b. Save 

2. Name the menu that has option to create a new document. 
3. What is the difference between Save and Save As options of File menu? 
4. Dhriti wants to open an already saved document in word processor. Since the mouse is not working 

properly, her teacher has asked her to use the keyboard shortcut. What is the keyboard shortcut for 
Open command? 

5. Sukrit has created a new document in word processor. Which option should he use – Save or Save As? 
6. Udit opened an already saved document ‘My Story’. He made few changes in the document. To save 

the changes, which option should he use – Save or Save As? 
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2.1 EDITING TEXT 
 
As we already know that there are so many advantages of creating document in word processor. One 
of the main advantages is that we can make changes in the document whenever we want.  
Editing means making changes into existing text.  
But before editing or formatting the text, you may need to select the text. Selection of text can be 
done with the keyboard or the mouse. 
The selected text gets highlighted with blue color. 
OpenOffice Writer features various tools to edit text in a document.  
 

2.1.1 Selecting consecutive text 
 
You can select consecutive text using mouse or the keyboard. 
 
<A> Selecting Text Using a Mouse 
 
To select text using a mouse, follow the steps: 

1. Place the cursor to the left of the first character  
of the text to be selected. 

2. Press the left mouse button and drag the mouse 
 to the position where you want to end selection. 

3. Release the mouse button.  
The selected text gets highlighted in  
blue color (Fig. 1). 
 

 
<B> Selecting Text Using Keyboard 
 
You can select text using even the keys on your keyboard. First, place the cursor to the left of the 
first character you wish to select. Then use the following key combinations: 
To select      Key combinations 
One character to the left    Shift + 
One character to the right    Shift + → 
One line up      Shift + 
One line down      Shift + 
To the end of the current line    Shift + End 
To the beginning of the current line   Shift + Home 
To the end of the current document   Shift + Ctrl + End 
To the beginning of the document   Shift + Ctrl + Home 
Entire document                   Ctrl + A 

 

Fig 1      Selecting text 

            Unit 2. Edit, Save and Print a Document in Word Processor 
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<C> Selecting non-consecutive text items 
  
You can also select non-consecutive text in a 
word processor. (Fig 2) 
 
To select non-consecutive text in a document 
using 
mouse: 

1. Select the first text. 
2. Press and hold down the Ctrl key. 
3. Select the next text. 
4. Repeat steps 2 and 3 for other text. 

 

 

 

 

 

 
 
<D> Inserting and Overtyping Text 
 
You can insert (add) text into the existing text or overtype (replace old text with the new one) text in 
OpenOffice Writer.  
To insert text, press the Insert key, to turn ON the Insert mode, which is indicated by INSRT appearing 
on the status bar (Fig. 3). 

 

 

 

 

 

 
Fig. 3      INSRT on the status bar 

 
Sometimes, you may need to type and replace the current text. This can be done using the Overtype 
mode. To overtype text, press the Insert key or click on INSRT on the status bar to turn ON the 
Overtype mode, which is indicated by OVER appearing on the status bar (Fig. 4) 

 

 

 

 

 

 

 

 
<E> Inserting a Blank Line 
You can also insert a blank line between two existing lines. The steps are: 
 

INSERT mode selected 

on the Status bar 

OVER mode selected on the Status bar 

Fig. 4    OVER on the status bar 
 

Let’s Try 
 
Open an already saved document. Practice selecting a sentence, any word, a paragraph, and the entire 
document. (Practice using keyboard and mouse). Also try selecting non-consecutive words or text. 
 
 

Fig.2 . Selecting Non-Consecutive Text 
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1. Place the cursor at the end of the line after which you want to insert a blank line. 
2. Press Enter. You will notice that the next line gets shifted down and a blank line is inserted. 
 
<F> Deleting Text 
You can easily delete a character, a word, or a block of text in Open Office Writer. Let us learn how 
to delete a character, a block of text or a word. 
 
To delete a character, the steps are: 
1. Position the cursor to the left of the character to be deleted. 
2. Press DELETE.  
Or 
1. Position the cursor to the right of the character to be deleted. 
2. Press BACKSPACE. 
 
To delete a block of text, the steps are: 
1. Select the text to be deleted. 
2. Press DELETE or BACKSPACE. 
 
To delete a word, the steps are: 
1. Place the cursor to the left of the word to be deleted. 
2. Press Ctrl + Delete. 
Or 
1. Place the cursor to the right of the word to be deleted. 
2. Press Ctrl + Backspace. 

 

<G> Undo and Redo Commands 
 
The Undo command is used to reverse the last 
command/action. 
To reverse the last action, click the Edit button and then click 
Undo in the drop-down menu. (Fig 5) 
Or 
Click the Undo  button on the Standard bar. (Fig 6) 

 

 

 

 

 

 

 

 

 

 
The Redo command is used to reverse the last Undo action. To apply this command, click the Redo 
option from the Edit menu. 
Or 
Click the Redo  button on the Standard bar.(Fig 6) 
 

Keyboard Shortcut 

Undo   Ctrl + Z 

Redo   Ctrl + Y 

Fig 5.    Undo option of Edit menu. 
 

 

 

Fig 6    Undo button on the Standard toolbar 
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Note: As long as there is nothing to redo, the Redo command will show up as Repeat command. The 
function of the Repeat command is to repeat the last thing you did in OpenOffice Writer. When you 
undo an action, the Repeat command changes to Redo. 
 
<H> Copying Text 
 
You can easily copy text from one place to another in a document. For this purpose, you will have to 
use Copy and Paste commands. The Copy command creates a duplicate of the selected text and the 
Paste command pastes the copied text at the position where the cursor is placed. 
 
To copy text from one location and paste it at another location, the steps are: 
1. Select the text to be copied. 
2. Click the Copy option from the Edit menu. 
Or 
Click the Copy  button on the Standard bar. (Fig 7) 
3. Position the cursor at the location where you want to paste the 
text.  
4. Click Paste option from the  Edit menu. 
Or 
Click the Paste button on the Standard bar. (Fig 7) 

 
<I> Moving text 
 
You can easily move text from one position to another using Cut and Paste commands. The steps to 
move text from one location to another are: 
 
1. Select the text to be moved. 
2. Click the Cut option from the Edit menu.  
Or 
Click the Cut  button on the Standard bar. (Fig 7) 
3. Position the cursor at the location where you want to paste the text. 
4. Click Paste option in the Edit menu or Paste button on the Standard bar. 
 

 

 

 

 

 
2.2 WRAPPING AND ALIGNING TEXT 

 
2.2.1 Wrapping Text 

 
Text wrapping is a feature that automatically starts a new line when a word in a sequence reaches the 
border of a picture, a text box, or the margin. There are different options to wrap text around the 
image. The steps are: 

1. Select the image. 
2. Select Wrap option from the Format menu. 
3. Select the desired option. 

 

 

Keyboard Shortcut 

Copy  Ctrl + C 

Cut  Ctrl + X 

Paste  Ctrl + V 

Fig 7    Standard bar 
 

 

Let’s Try 
 
Open an already saved document in Writer and practice deleting text using Delete key, backspace key. 
Also practice copying and moving text. 
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2.2.2 Setting Alignment 
 
Alignment is the manner in which text is placed within the 
margins of a page. Alignment is used to create attractive, and 
readable pages in a document. Proper alignment makes the 
document visually appealing and easier to read.  

 
The steps to change the alignment of text are: 

1. Select the text.  
2. Select Paragraph option from the Format menu. 
3. The Paragraph dialog box appears. (Fig 8). 
4. Select the desired alignment option. 
5. Click OK. 

 
Or 
 
 
 
You can click a desired alignment button on the Formatting bar (Fig 9) 
 
 

 

 

 

 

 

 

 
Fig. 9   Alignment buttons on the Formatting bar 

 

 

 

 

 
 
Or 
Click the Format menu and then click Alignment in the 
drop-down menu (Fig. 10). Select the desired option from  
the submenu. 
 

 

 

 

 

 

 

 

Left Align 

Center Right Justify 

Fig  8. Alignment tab of Paragraph dialog 

box 

 

Fig. 10 Alignment option in the Format menu 
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2.3 FONT SIZE, TYPE AND FACE 
 
Another advantage of word processor is that we can change the appearance of the text by changing 
the size, color and style. Formatting is the process of changing the appearance of the text in a 
document through the use of various fonts, font colors, font sizes, etc. 
 
Some settings are pre-defined in Writer. These pre-defined settings in a software are called default 
settings. You can also make changes in the default settings.  
 
The font size or text size is the overall size of a character shown on the computer screen or the printed 

page. A font is typically measured in unit called point (pt). There are approximately 72 points in one 

inch or 2.54 cm. 

Font style refers to whether the font or text is displayed in bold, italics, underlined or normal. We can 

apply more than one style to the characters. 

A typeface is a style of lettering. For example, Times New Roman is a typeface. 

A font is a specific size and style of a typeface. For example, ‘14pt Times New Roman Bold’ is a font. 

Each style of font (Arial, Callibri, etc. are stored in a separate font file. 

 
 
 
 
2.3.1 Formatting Text 
Text formatting can be done either by using the Format menu or by using the Formatting toolbar. 
 
<A> Text Formatting Using the Format Menu 
1. Select the text. 
2. Click the Format menu bar and then select Character option. The Character dialog box appears. 

• You can change the font, font size, and typeface using the Font tab in 
the dialog box (Fig. 11). 

• Click on the Font Effects tab to change the font color, font effect, and apply other styles such 
as underlining (Fig. 12). 

 

Let’s Try 
 

Open an already saved document in writer. Also try different alignment options. 
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• You can change the position of the text (e.g., superscript, subscript, etc.) using the Position 

tab (Fig. 13). 
4. Click OK after choosing the desired options. 

<B> Text Formatting Using the Formatting Bar 
 
The Formatting bar has various buttons on it, as shown in Figure 14. These buttons can be used for 
formatting text. 

 

 

 

 

 

 

 
Fig. 14 Formatting bar 

 
 
 
 

Select Font Select Typeface Select Font 

size 

Select Font Font  

Size 

Bold 
Italic 

Underline 

Text 

Color 
Highlighting 

Fig. 12 Font Effects tab of the 
Character dialog box 

 

Fig. 13 Position tab of the Character dialog 
box 

 

Keyboard Shortcuts 
 
Bold   Ctrl + B 
Italic   Ctrl + I 
Underline  Ctrl + U 
 

Fig. 11 Font tab of the Character dialog box 
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2.3.2  Change Case 
 
Sometimes you type the entire text in upper case and after typing you realize that it should have 
been in lowercase or vice - versa. You need not type the entire text again but use the Change Case 
option to change the case of text. The steps are: 
 
1. Select the Change Case option from the Format menu. (Fig. 15). 
2. Select the desired option in the submenu. 
Sentence case  The first character in a sentence is capitalized and the rest are in lowercase. 
lowercase    All characters are in lowercase (small letters) 
UPPERCASE   All characters are in uppercase (capital letters) 
Capitalize Every Word  The first character of each word is capital and the rest are in lowercase 
tOGGLE cASE   Changes lowercase characters to uppercase and 
uppercase characters to lowercase 
 

 

 
                    Fig. 15 Change Case option in the Format menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

 

Let’s Try 
Open an already saved document in Writer. Try different Change Case options. 
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Let’s Try 
 

1. Start OpenOffice Writer. 
2. Create a new document and type the following text: 

 
 

 

 

 

 

 

 

 
 
 

3. Select the second paragraph using the mouse. 
4. Now, make a copy of the selected paragraph at the end of the document. 
5. Undo the last action. 
6. Format the text according to the following specifications: 

a. Heading should be in Comic Sans MS font and font size 16. 
b. Paragraph text should be in Times New Roman font and font size 14. 

7. Save the file as ‘good health’. 
Final document will appear as shown below. 

 

 

Secrets of Maintaining Good Health 

We can keep good health by having good eating habits. We should take  balanced diet in accordance with 

planned timings. 

We should ensure that our meal incorporates the five food groups: cereals and grains, pulses and legumes, 

fruits and vegetables, milk and meat products, nuts and oils. 

We should drink at least two liters of water every day to maintain the water balance of the body, flush out 

toxins and prevent dehydration. 

Oil, ghee, butter are actually healthy, but we should minimize their use. Healthy alternatives like, steaming, 

boiling, roasting, etc. should be adopted in cooking. 

For best results, include regular exercise, regular check-ups, positive thinking, yoga and meditation. 

Secrets of Maintaining Good Health 

We can keep good health by having good eating habits. We should take balanced 

diet in accordance with planned timings. 

We should ensure that our meal incorporates the five food groups: cereals and 

grains, pulses and legumes, fruits and vegetables, milk and meat products, nuts and 

oils. 

We should drink at least two liters of water every day to maintain the water balance 

of the body, flush out toxins and prevent dehydration. 

Oil, ghee, butter are actually healthy, but we should minimize their use. Healthy 

alternatives like, steaming, boiling, roasting, etc. should be adopted in cooking. 

For best results, include regular exercise, regular check-ups, positive thinking, yoga 

and meditation. 
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2.4  HEADER AND FOOTER 
 
Header is the text that is printed at the top of each page (in the top margin) in a document. Footer is 
printed at the bottom of each page (in the bottom margin). 
Header and Footers provide additional information about the document, like, date, page number, 
etc. 
 

2.4.1 To insert headers and footers in a document; 
1. Select Insert ➢ Header or Footer ➢ Default. 

The header area appears at the top of the document. (Fig 16) Type the header. 
Or 

2. Select Page option from the Format menu.  
a. The Page Style: Default dialog box appears. 
b. Click the Header tab (Fig. 17) or the Footer tab (Fig. 18). 
c. A box will appear at the top and the bottom area of the page, respectively (Fig. 19). 

3. You can either type text or add date and time by selecting the Fields option in the Insert 
menu. 

4.  Click in the document area to finish adding header or footer information. 
 
 

Worksheet 
 

1. Madhur wants to make a copy of the paragraph he has typed in the document. Name the set of 
commands he should use to make a duplicate of the selected text.  

____________________  
2. Pranav has typed the paragraph at wrong position. Write the set of commands used to move 

the text from one position to another in a document. 
_____________________  

3. Write keyboard shortcut for the following commands: 
a. Copy 
b. Cut 
c. Paste 
d. Undo 

4. Vedika has to make the important words darker than the normal text. Which command of word 
processer can she use to make the text darker than the normal text? What is the keyboard 
shortcut for this command? 

____________________  
 

5. Sukrit has typed a document in word processor. He wants to make entire text in the document 
bold. How can you select entire document using the keyboard? 

______________________  
6. Name the command used to reverse the last action. 

_____________________________  
7. Name the menu that has option to change the text color and size. 

_______________________________  
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2.4.2 Removing Header or Footer 
 
To remover header of footer, the steps are: 

1. Select Insert ➢  Header or Footer ➢   Default. 
2. A message box appears (Fig 20). 
3. Click Yes to delete the header or footer. 

 

 

2.5 AUTOCORRECT 
 
One of the main advantages of creating a document in word processor is that we easily come to know 
about our spelling and grammatical mistakes done while typing. These can be easily corrected using 
the options available in word processor. While typing in an OpenOffice Writer document you will 
notice red or blue wavy lines under the text. A red wavy line indicates a misspelled word and a wavy 
line indicates a grammatical mistake. 

Fig 16 Typing Header 
 

 

Fig. 17 Header tab of the Page Style: 

Default dialog box 

 

Fig. 18 Footer tab of the Page Style: 
Default dialog box 

 

 

Fig. 19 Inserting header 
 

Fig 20 Message box 
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OpenOffice Writer provides the following two ways of checking spelling and grammar in a document: 
• Using AutoSpellcheck 
• Using the Spelling and Grammar option 
 

2.5.1 Using AutoSpellcheck 
The steps to check spellings as you type are: 

1. Click the AutoSpellcheck button  on the 
Standard bar. 
2. Right-click the misspelled word (with a red wavy 
underline) and then choose a word from the 
suggested list  
          Or  
from the AutoCorrect submenu (Fig. 21). 
If you choose a word from the AutoCorrect 
submenu, 
the misspelled and the replacement words are  
automatically added to the AutoCorrect list for the 
current language. 
 

 
2.5.2  Using the Spelling and Grammar Option 
The Spelling & Grammar option of OpenOffice Writer helps you check the spelling and grammatical 
errors in your document. The steps are: 

1. Select the Spelling and Grammar option from the Tools menu. 
Or 

Click the Spelling and Grammar  button on the Standard bar.  
   Or 
 Press F7 

2. The Spelling dialog box appears (Fig. 22).  
a. The unrecognized word is displayed in the Not in Dictionary text box and the 

suggestions are displayed in the Suggestions box. 
b.  On clicking the desired button, the respective action takes place and the next word is 

highlighted.  
c. Repeat this step until a message box saying The spell check is complete is displayed. 

(Fig 23) 
       3. Click OK. 

Fig 21 AutoCorrect submenu 
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2.6 NUMBERING AND BULLET 
 
A list is a way of organizing items in a document. This helps the reader 
to understand the key points easily. Lists can be created for step-by-
step instructions to a series of points. Word processor has option to 
create numbered or bulleted list.  
 
A numbered list is created if the order of items is very important. A 
numbered list is also called ordered list. You can use different 
numbering styles – numbers, roman numbers, or alphabets to mark 
the items in a numbered list.  
 
A bulleted list is used when order of items is not very important. This 
is also known as unordered list. A bullet or symbol is used to mark the 
items of the list. For example, let’s create a list of items to be purchased for your birthday party. Since 
the order of these items is not important, it can be a bulleted list. 
But, if you use numbers or alphabets to mark these list items, then it 
will become a numbered or ordered list. 
 
To create a bulleted or numbered list, do as follows: 
1. Place the cursor at the position where you want to start the list. 
2. Select Bullets and Numbering option from the Format menu. 
3. The Bullets and Numbering dialog box appears. 
4. Click the Bullets tab (Fig. 24) or the Numbering type tab (Fig. 25).  
5. Choose the desired style and click OK. 
6. Type the list item. After typing each list item, press the Enter key. 
 

 

 

 
 
 
 

Fig  22 Spelling dialog box 
 

 

Fig 23 Message box 
 

Fig. 24 Bullets tab of the Bullets and 

Numbering dialog box 

Fig. 25 Numbering type tab of the 
Bullets and Numbering dialog box 
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You can also create lists using the Bulleted list button or the Numbered list button on the 
Formatting bar. (Fig 26) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
2.7 CREATING TABLE 
 
Tables in a document can be used to present information. It is easier to read or present information 
in a tabular format.  A table is arrangement of data arranged in rows and columns. Word processor 
uses tables to place information into rows and columns. Your class Time Table is an example of a table. 
A column is a vertical series of cells in a table. 
A row is a horizontal series of cells in a table. 
The intersection of row and column forms a  
rectangular box called cell. 

 
Tables can be created in OpenOffice Writer in any one of the  
following ways: 

• Using Table button 

• Using Table menu 
 
 

2.7.1 Creating a Table Using the Table Button 
The steps to create a table using the Table button are: 

1. Click the drop-down menu arrow of the Table button 

Numbering Bullets 

 

  

  

  

 

Cell 

Rows 

Columns 

Fig 26  Formatting bar 
 

Let’s Try 
 
Create a document in Writer and type a bulleted list of festivals celebrated in your country. Give heading 
as ‘List of Festivals’. Also choose suitable font, size and color for the list text and heading. 
 

 

Let’s Try 
 

Create a new document in Writer and type the following list. 

1. Operating System 

a. Windows 8 

b. Windows 10 

2. Microsoft Office 

• MS Word 

• MS PowerPoint 

• MS Excel 
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 on the Standard bar.  
2. A grid of cells appears. Move the mouse pointer in  

the grid to highlight the number of rows and columns 
required in the table (Fig. 27). 

3. A table will be inserted at the insertion point. 
 
 

2.7.2 Creating a Table Using the Table Menu 
The steps to create a table using the Table menu are: 

1. Select Table ➢ Insert ➢ Table. 
Or 
Press Ctrl + F12. 
Or 
         Select Insert  ➢ Table 

2. The Insert Table dialog box appears.  
a. Specify the number of columns 
b. Specify the number of rows 

4. Click OK 
 

2.7.3 Entering data in a cell 

 
To enter data in a cell, click in the cell and then type the text. 
 

2.7.4 Selecting row or column 
 
To select a row or a column, click and drag the mouse button. 
 

2.7.5 Inserting/Deleting Rows/Columns 
 
A table can be modified by inserting or deleting rows or columns, and by merging or splitting cells. 
 
<A> Inserting Rows  
 
You can easily insert (add) new rows in a table in a Writer 
document. The steps to insert rows in a table are: 

1. Position the cursor in the cell where you want to insert 
 a new row or a column. 
2. Select Table ➢ Insert ➢ Rows. 
3. The Insert Rows dialog box appears (Figs. 28). 
 a. Specify the number of rows to be inserted. 
 b. Select the position – Before or After the selected row. 
 c. Click OK. 
 

<B> Inserting Columns 
Columns can also be inserted in a document. The steps to insert columns in a table are: 
1. Position the cursor in the cell where you want to insert a new column. 
2. Select Table ➢ Insert ➢ Columns. 
3. The Insert Columns dialog box appears. 
 a. Specify the number of columns to be inserted. 
 b. Select the position – Before or After the selected column. 
 c. Click OK. 

Fig. 27 Table Button 
 

Fig. 28 Insert Rows dialog box 
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<C> Deleting Rows  
To delete rows in a table: 
1. Select the rows to be deleted. 
2. Select Table ➢ Delete ➢ Rows. 
 
<D> Deleting Columns 
To delete columns in a table: 
1. Select the columns to be deleted. 
2. Select Table ➢ Delete ➢ Columns. 
 
<E> Merging the Cells of the table 
You can also merge (combine) cells in a table. The steps are: 
1. Select the cells to be merged. 
2. Select Table ➢ Merge cells. 

 
<F> Splitting the Cells of the table 
You can split (divide) a cell into required number of rows or 
columns. The steps are: 
1. Click in the cell to be split. 
2. Select Table ➢ Split Cells. 
3. The Split Cells dialog box appears (Fig. 29). 
a.  Enter the number of parts in which you want to 
 split the selected cell. 

b. Specify the direction—Horizontally or  
Vertically—in which you want to split the 
 cell. 

c. Click OK. 
 
<G> Applying Borders and Background to the table 
You can apply borders and background color to the entire table or selected cells of the table. The 
steps to apply borders and background to a table are: 
1. Select the table or rows/columns/cells. 
2. Select Table ➢Table Properties. 
3. The Table Format dialog box appears  
a. Click the Borders tab (Fig. 30). Select the line style and line color. 
b.  Click the Background tab.(Fig 31). Choose the desired background color. 
c. Click OK. 

 

Fig. 29 Split Cells dialog box 
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Fig. 30  Borders tab of Table Format dialog box 
 

Fig. 31 Background tab of Table Format dialog box 
 

Let’s Try! 
 

1. Ishani was asked to create a document and give details of students who won prizes in 
various competitions. She has created the following document. 

 

 

 

 

 

 

 

 

 

 

Can you present this information in a tabular form to make it more presentable and easily 

readable? 

Senior Secondary Department 

 

Zonal Level (Group) 

Aryan  XI A 1st position   Nukkad Natak Competition 

Akshit               XI A 1st position  Nukkad Natak Competition 

Riya  XI F 1st Position  Stage Play  

Vasu        XI F 2nd Position Hindi Debate   

Sarthak    XI D 1st Position Hindi Extempore  
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2.8 FIND AND REPLACE 
 
Sometimes you may need to search a word or text in a document and replace it with another word or 
text. The Find option is used to search a word or text in a document and Replace command is used to 
replace the specific word or text in a document. 
The Find & Replace feature of OpenOffice Writer can be used to find a particular word or text in a 
document, or to replace a word or text in a document. 

 
2.8.1 Finding Text 

 
The steps to search a word or text in a document are: 

1. Select Find & Replace option from the Edit menu. 
2. The Find & Replace dialog box appears. (Fig 32). 

a. Type the word to be searched in the search for  
box. 

b. Click the Find button to locate the word one  
by one. Click the Find All button to highlight  
the word at all locations in the document. 
 

3. When the search is finished, click Close button. 
 

 
Fig 32 Find & Replace dialog box 

 

Lets Try 

2. The class teacher wants to keep record of students marks. She has asked Sidharth to design 
the following sheet in word processor. Can you design the same sheet in word processor? 

Evaluation Record 
 
Class and Section ____________________ 
 

Roll 

No. 

Name 

of the 

Student 

Evaluation Record 
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2.8.2 Finding and Replacing Text 
 
You can search a given word and replace it with another word in 
a document. The steps to find and replace a word or text are: 

1. Select Find & Replace option from Edit menu 
2. The Find & Replace dialog box is displayed. (Fig 33) 
3. Type the word to be searched in the Search for box.  
4. In the Replace with box, type the word or text with  

which you want to replace the word or text typed in  
the Search for box. 

5.  Click the Replace button to replace the word one by  
one, or click the Replace All button to replace the 
word at all locations in the document. 

6. When all the occurrences of the word are replaced,  
a message box will appear. Click No to discontinue and  
close the  Find & Replace dialog box. (Fig 34) 

 

 

 

 

 

 

 
2.9 PAGE NUMBERING 
 
You can add page numbers in the header or footer area. The steps are. 

1. Click in the header or footer area. 
2. Select    Insert➢  Fields  ➢ Page Number. 

 

2.10 PRINTING DOCUMENT 
 
To print a document, do the following: 
1. Select Print option from File menu. 
Or 

Click the Print button on the Standard bar. 
3. The Print dialog box appears (Fig. 35). 

 
a. Select the printer. 

 
b. Specify the range of pages to be 

printed. 
c. Specify the number of copies to be  

printed. 
d. Click the Print button 

Fig 33 Find & Replace dialog box 
 

Fig 34 Message box 
 

Fig. 35  Print dialog box 
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2.11 SAVING A DOCUMENT IN 
DIFFERENT FORMATS 
 
You have already learnt how to save a 
document in OpenOffice Writer. If you 
want to save a file in a different format 
other than the default format .odt of 
OpenOffice Writer. The Steps are: 
1. Select Save As option of File menu. 
2. The Save As dialog box appears.(Fig 

36) 
a. Select the File type from the 

 Save as type drop-down list. 
b. Type the filename. 
c. Click Save button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Do you know? 

When you create and save a document in MS 

Word, the filename has extension .docx Fig 36  Save As dialog box 
 

Lets Try it 1 
 

a. Design an advertisement for the ‘ABCD Personality Centre giving necessary details. Run spell 
check to check spelling mistakes. You can also insert suitable picture in the document. A 
sample is given below: 

 
 

ABCD Personality Development Centre 

New Delhi 

Join the centre for overall personality growth. 

The centre holds classes on: 

• English Speaking 

• Grooming and Etiquettes 

• Hobbies like, theatre, modelling, public speaking, yoga and meditation 

Admission open for children between the age group of 10 to 18 years. 

For further details contact 

Mr. ABC  98######90 

Let’s Try it 2 
 

1. Create a new document in OpenOffice Writer. 
2. Type an essay on the topic ‘Pollution’. 
3. Insert page number as footer and ‘Pollution’ as header. 
4. Use autocorrect to correct the spelling mistakes. 
5. Save the document in .doc format so that it can be opened in Microsoft Word also. 
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Worksheet 2 

 
1. By mistake, Sooraj has typed the entire document in small letters. Which option of Change Case 

option will he use if he wants to have only first character in capital and rest in small letters in a 

sentence? Name the menu that has the Change Case option. 

2. Identify the case of the following sentence: 

You Need Not Type The Entire Text Again. 

3. While type an article in Writer, Yuvan noticed red or blue wavy line under some text. What does 

red and blue wavy lines indicate? 

4. Yatish wants to search a word ‘morning’ in the document and replace it with ‘evening’. Name 

the feature of word processor that he can use for this purpose. 

5. Pooja has created a list with list items marked with symbol dot. Which type of list is this? 

6. You cannot apply border to selected cells in a table (True/False). 

7. Oorja wants to print page number at the bottom of every document. Which feature of Writer 

can she use for this purpose? 

 
 
 
 

Lets Try it 3 
 

1. Create a new document in OpenOffice Writer. 
2. Design your class time table. 
3. Format the text in the table. 
4. Apply border to the table and shading to the cells of the table. 

 

Worksheet 
 

1. Write keyboard shortcut for the following commands: 
a. Spelling and grammar option   ___________  
b. Find and Replace   ______________  

2. Name the menu that has option to change the alignment of text in a document.   
_________________________   

3. Name the four alignment options. 
__________________   
__________________  
_________________  
_________________  

4. The intersection of row and column in a table is called a ________. 
5. What is the name given to the text printed on top of each page of the document?   

___________  
6. What is the name given to the text printed at the bottom of every page in a document? 

__________  
7. AutoSpellcheck option is available on ___________ bar. 
8. A ________ list is used when the order of items is important. 
9. The default bullet style is ________________. 
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Entrepreneurship starts with thinking and acting on a business idea. However, before jumping to an 
idea, it is important to develop certain entrepreneurial skills and com petencies in the process. One 
of the most important skills required to become a successful entrepreneur are problem solving and 
creativity. Apart from the skills, it is also important to understand how different value systems, 
motivations and attitudes also influence entrepreneurial success. Ideation is a creative and iterative 
process. In this chapter, we will focus on how ideas can be generated, how to understand needs and 
wants of potential customers and how to assess the competitive landscape for a business idea.  
 

 

 

 

 
In sociology, values are defined as standards and guidelines that influence a person’s behavior and 
attitude.  
 
Values are basically the beliefs about what 
matters the most, how to behave and which 
goals are important to achieve. 
  
Milton Rokeach defines values as beliefs that 
guide judgement and actions for various 
situations. To an extent, a person’s values 
influence how he or she decides between right 
or wrong, desirable or undesirable and good or 
bad.  

According to Schwartz, some elements of values 
include: 

• Values are based on concepts or beliefs. 

• Values guide the selection and evaluation of specific behaviors and events. 

• Values are set in an order of relative importance. 

• Values differ based on motivational objectives. 

• Values are not confined to specific situations or behaviors  

There are three types of values: 

• Personal 

• Professional 

• Social 

Every entrepreneur must be aware of their “core value”, which is that one thing that is the most 
important to them It is summarized in the following diagram: 
 

 

     Class XI                Entrepreneurial Skills 

1. Introduction 

2. Values 
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Action factors are basically divided 
into personality and environment 
factors, as they largely influence the 
actions taken by an individual and also 
directly influence what matters to the 
individual.  
 
Personality factors are those factors 
that are internal and innate to your 
personality. They will drive your 
values as personality influences the 
way one would naturally behave. For 
example, if you have an extroverted 
personality, you might value building 
social relationships.  
 
Environment factors are those factors are external and exist in the environment around you. These 
factors include things we observe, hear, see and people we engage with in our external environment, 
which influences our thinking about what holds significance. For example, if you see a lot of suffering 
around you on a regular basis, you might value being helpful and kind.  
 
From an organizational perspective, core values are the deeply ingrained principles that guide all of a 
company’s actions and serve as its cultural cornerstones. They turn out to be inherent and can never 
be compromised, either for convenience or short-term economic gain. For example, Comergent, a 
young e-business company, has successfully created a strong culture around dependability, 
dedication, and self-motivation by integrating these core values into every system that directly 
touches employees.  
 

Activity - I 

 
In the following activity, you are given a list of life values with their meanings. These represent 
different traits and qualities that entrepreneurs and leaders across the world resonate with.  
 
Step 1: 
 
You have to pick the values you feel the most strongly about. Start with the top ten and finally decide 
your top five values. Think about these questions if you are facing a difficulty choosing them: 
 
Who do you look up to? This can be anyone from friends and family or someone you idealize. Why do 
you look up to them? 
What are some recurring things that your closest people keep telling you? 
What is it that you want to achieve for which you will exceed your limits? Lots of money?  To meet you 
family if they are away? To become a celebrity? To travel the world? 
If you feel stuck, feel free to discuss it with someone close to you. 
 

Achievement a sense of accomplishment, mastery, goal achievement 

Advancement continuous betterment and improvement 

Adventure engaging in new and challenging opportunities, excitement, 
risk 

Aspiration hope or ambition of achieving something 
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Authority position and power to control events and other people’s 
activities 

Autonomy ability to act independently with few constraints and to make 
most decisions and choices 

Balance giving proper weight to each area of one’s life 

Change an act or process through which something becomes 
different 

Close relationships strong, deep or close association between two or more 
people 

Community sense of belongingness with people who share common 
attitudes and interests 

Competence the ability to do something successfully or efficiently 

Competitiveness possession of a strong desire to be more successful than 
others 

Cooperation the action or process of working together to the same end 

Creativity the use of imagination or original ideas to create something 

Decisiveness the ability to make decisions quickly and effectively 

Economic security steady and secure employment, adequate financial reward, 
low risk 

Effectiveness the degree to which something is successful in producing a 
desired result 

Efficiency quality of working in a well-organized and competent way 

Ethical practice practicing the moral principles that govern a person's 
behaviour  

Excellence the quality of being outstanding or extremely good 

Excitement a feeling of great enthusiasm and eagerness 
Fairness impartial and just treatment or behaviour without 

favouritism or discrimination 
Fame the state of being known by many people 

Freedom the power to act or speak without externally imposed 
restraints 

Growth the process of developing physically, mentally, emotionally 
and  spiritually 

Help helping other people attain their goals, provide care and 
support 

Honesty the quality of being free of deceit; truthful and sincere 

Independence the state of being free from outside control; not subject to 
another's authority 

Influencing others having an impact or effect on the attitudes or opinions of 
others 
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Integrity acting in accord with moral and ethical standards; honesty, 
sincerity, truth, trustworthiness 

Knowledge understanding gained by experience or education of a fact or 
a situation 

Leadership ability to lead a group of people 

Learning gain or acquire knowledge 

Openness to Experience trait of being open to try and enjoy new things and being 
curious  

Opportunity chance of doing something new 

Optimism hopefulness and confidence about the future or the success 
of something 

Personal development dedication to maximizing one’s potential 
Recognition   positive feedback and public credit for work well done; 

respect and admiration 

Resourcefulness the ability to find quick and clever ways to overcome 
difficulties 

Reputation the beliefs or opinions that are generally held about someone 
or something 

Responsibility  dependability, reliability, accountability for results 

Security the state of being free from danger or threat 

Self-reliance reliance on one's own powers and resources rather than 
those of others 

Self-respect pride, self-esteem, sense of personal identity 

Stability the state of being sane and sensible; not easily upset or 
disturbed 

Status being respected for one’s job or association with a prestigious 
group or organization 

Wealth an abundance of valuable possessions or money 

Wisdom sound judgment based on knowledge, experience, and 
understanding 

 
Step 2: 
 
Now, think about why you picked these five values. Find a partner and share the reasoning or story 
behind the five values you picked and how those values are going to guide your personal and 
professional goals. 
 
Step 3: 
 
Finally, pick only one value that is most important to you. This one value will be your “core value”. 
 
In the above activity, you tried to find your own values or things that you think are important to you.  
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Entrepreneurship is considered to be a value-driven process, as there is a higher chance of the 
entrepreneur to be motivated to sustain the business in the long run. Entrepreneurial values are some 
key values and beliefs that entrepreneurs are seen to have and that have influenced or encouraged 
entrepreneurial behaviour. These deeper beliefs influence one’s decision making and opinions. An 
entrepreneur needs to balance between personal, professional and social values.  

3.1 Personal values for an entrepreneur include passion, honesty, integrity, determination, 
confidence, wisdom, cooperation, decisiveness, humility etc. These values are reflected in a person’s 
personality and in their perception about certain things. No one really likes to do business with 
someone who is dismissive, arrogant, egoistic, argumentative and dishonest.  
 

3.2 Professional values correspond how an entrepreneur conducts himself or herself in the 

professional business and workplace environment. Ethics in the business world are also the domain 
of professional values. Professional values guide entrepreneurs towards being an effective team 
leader. Some professional values include advancement, balance, authority, leadership, 
competitiveness, efficiency, opportunity, ethical practice, resourcefulness, excellence etc. These 
values encourage self-determined action in a professional setting.  
 

3.3 Social values are values that make entrepreneurs look beyond the core business and have a 
bigger purpose. These values are what drive entrepreneurs to make the business socially acceptable. 
In terms of business, social 
values also influence the 
objectives of business and 
the manner in which 
business matters should 
be carried out. Some social 
values an entrepreneur 
must possess include 
change, creativity, 
fairness, kindness, 
patriotism, empathy etc. 
This encourages 
entrepreneurs to take 
action that benefit the 
society as well.  
 

Some entrepreneurial 
values are as follows: 
 

3.4 Independence: To 
savour the sense of 
achievement, 
entrepreneurs need to 
be independent. The feeling of being independent creates a positive and strong ego and enables the 
entrepreneur to develop a mission towards their goal. This trait of self-reliance and self-sufficiency 
serves as an important asset for the entrepreneur to increase their confidence and courage to 
innovate. 
 

3.5 Respect for work: An entrepreneur cannot succeed if he/she does not respect and values their 
work. It is important for an entrepreneur to work hard and keep trying different alternatives to sustain 
and grow their venture. This encourages the entrepreneur to keep pursuing a career path in which 
rewards and incentives are dependent on the amount and quality of hard work and effort put in.  

3. Entrepreneurial Values 
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3.6 Respect for others: Mutual respect towards others and one’s employees is an important value 
for entrepreneurs. This also includes value for their work, time and effort. It enables the 
entrepreneur to appreciate others’ efforts, relate effectively to vendors, employees and community, 
build long-lasting and healthy relations and increases their self-esteem as well.  
 

3.7 Trust: Usually overlooked in a professional setting, trust plays a key role for an entrepreneur in 
different aspects of life. An entrepreneur must trust their own vision or goal, develop mutual trust 
with employees, make customers trust his product/service, develop a trustworthy relationship with 
vendors etc.  
 

3.8 Honesty: It is very important for an entrepreneur to be honest and ethical. Honesty is must 
financing the business, managing the assets of the firm, taking decisions that involve risks and making 
choices that are hard. An ethical entrepreneur is always driven by honesty.  
 

3.9 Vision: Vision guides the entrepreneur through the business planning process, clarifying the 

opportunity and setting goals for the organization. Vision allows the entrepreneur to see past his or 
her current position and beyond limited resources to more fully appreciate the potential of the 
venture. 

 
3.10 Outstanding performance: Entrepreneurs are always ready to face and resolve the challenges 

They set for themselves certain standards of outstanding performance and excellence and can deal 
with unexpected obstacles with confidence. Most companies experience three or four life-threatening 
crises in their early years; to survive this period, the true entrepreneur deals with these crises and 
wins through. 
 

3.11 Initiative and ownership: Entrepreneurs derive great satisfaction by taking initiative and in 

their sense of ownership. They take initiative to do many things and commit to executing tasks. This 
gives them a sense of complete identification and encourages them to learn from their own decisions.  

 
3.12 Creativity and innovation: Entrepreneurs value creativity as they constantly have to use their 
imagination or original ideas to create something new. Similarly, they like to innovate in a lot of 
aspects of the business by making small incremental changes.  
 
In any civilized society, values and qualities like truthfulness, honesty, harmony, integrity etc. as given 
high regard for a healthy, peaceful and happy living. As we are aware, these beliefs that serve as 
standards and influence behavior are known as values. Since entrepreneurs also share some of these 
beliefs and qualities that guide and direct certain behavior in them, they are termed as entrepreneurial 
values.  
 
Skill-Based Activities: 
 

I. Value System 
 

• Make your own list of at least 10 entrepreneurial values that you think are important. 

• Discuss in groups how these entrepreneurial values play a role in an entrepreneur’s life. 

• Reflect on what values do you exhibit during activities such as ice breaking, rapport building, 
group work and home assignments. 
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Attitude is defined as a set of beliefs, emotions and behaviours towards a particular place, object, 
person, situation, event, ideas or thing.  
 
An individual’s experiences and circumstances shape their attitude towards things. Some social 
psychologists also define attitude as a learned tendency to evaluate situations and things in a certain 
manner.  
 
Attitude influences intended behavior intrinsically, without any external intervention. It is not always 
possible for an individual to be conscious of his or her attitude as it comes subconsciously to them. 
While attitude, and sometimes behavior cannot be realized, it can be watched based on its 
repercussions and consequences. For example, a high level of productivity can be assumed to be 
directly proportionate to a positive attitude for work.  
 

Activity II 

 
We have always heard people saying that a person has either a positive attitude or a negative 
attitude. People show a positive attitude for some things and a negative attitude for some things. 
This can vary depending on a person’s goals, one’s motivation factors, skills, self-belief, economic 
status and opportunities. 
 
What does it really mean? What type of attitude should one behold? Is it really possible for a person 
to be positive or negative all the time?  
 
Read the following statements and answer the statement signifies positive attitude or negative 
attitude. 
 

Statement Answer 

1. I have been trying very hard but I still always have to face 
failure. 

 

2. Some stories and works really inspire me to perform better.  

3. I am tired of getting criticism for my ideas.  

4. This work is boring and nonsensical.  

5. I think I gave my best but I think there are some areas where I 
need to improve. 

 

6. I want to continuously keep learning about different fields and 
industries. 

 

7. I think I am inferior to me teammates because I feel they are 
better at doing the work than me. 

 

 

 

 

 

 

 
Entrepreneurs often exhibit certain attitudes. Similarly, some attributes related to one’s attitude are 
needed to have the right mindset for achieving entrepreneurial success. Some of these are as follows: 
 

4. Attitude 

5. Entrepreneurial Attitudes 
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5.1 Use imagination: In entrepreneurship, use of imagination and creativity provides a structure to 
entrepreneurs to think out of the box, consider alternatives, try unconventional ways to do things and 
continuously improvise and iterate.  
 

5.2 Take moderate risks: Moderate risk takers are those entrepreneurs who are often characterized 
as willing to assume a moderate amount of risk in business, being neither overly conservative nor 
likely to gamble. 
 

5.3 Look for economic opportunities: The trends in industries and businesses keep changing. In 

various situations, entrepreneurs can feel uncomfortable when implementing a needed change in 
people, technology, product, mission, etc. An entrepreneur has to step out of his or her comfort zone 
and focus on pursuing and trying different economic opportunities. They must continuously. 
 

5.4 Enjoy freedom of decision making and action: If an entrepreneur does not decide to take a 
particular action, the action will not happen. Entrepreneurs have to decide to do something and then 
do that. This is the logical process of how they can take action.  
 

5.5 Analyse situations and plan actions: Part of having an entrepreneurial attitude is to assess 
and analyse situations, 
understand challenges 
given the situation and 
plan action steps 
accordingly. 
Entrepreneurs must 
not be afraid to plan 
and take real action. 
Planning and 
executing actions are 
something that can 
lead to successful and 
timely business 
activity.  
 

5.6 Be able to deal 
with fear: No one can live without experiencing fear. Knowing this truth will enable you deal with 

fear.  In business, many challenging tasks can create pressure and instil fear in an entrepreneur, such 
as repaying a loan, launching a new prod uct, losing employees etc. It is important for an entrepreneur 
to overcome the fear and take the leap.  

 
5.7 Accept feedback and criticism positively: Constructive feedback can prove to be extremely 
valuable for entrepreneurs. Many times, customers, industry partners, consultants etc. might criticize 
the idea or a certain action. An entrepreneur must always be open to this and take it positively rather 
than getting demotivated or negative about it.  
 

5.8 Get involved in all activities: An entrepreneur cannot afford to procrastinate or be laid back. 
While planning helps, it is important for an entrepreneur to make timely decisions. Even when there 
are ups and downs while building the business, it is important to rebound from the setbacks and keep 
moving forward. For this, an entrepreneur needs to be involved in all activities.  
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5.9 Have clarity of purpose: When an entrepreneur has clarity of purpose, he/she will always 
have the confidence to execute.  Without clarity of purpose, an entrepreneur cannot inspire staff, or 
potential clients, or even vendors. 
 

5.10 Believe the change you want to bring: Self-believe and faith is an important part of an 
entrepreneurial attitude. This is because getting bogged down by things can come inevitably to the 
entrepreneur. It is imperative for one to believe in one's own self, in one's vision, in one’s company, 
and in one’s people. This confidence helps to keep employees, stakeholders, customers and suppliers 
believe in the business and its mission as well. 
 

5.11 Be passionate: Passion is key for entrepreneurial success, because one cannot deal with 
frustrating situations or overcome challenges if one does not feel passionate about the business. This 
also helps to persuade others to stay motivated. Most successful entrepreneurs feel passionate about 
their ideas, daily tasks, creations and goals.  
 

5.12 Be flexible: Sudden adversities, changes and hurdles are a part of entrepreneurial journey. An 

entrepreneur has to maintain a positive attitude, be open and flexible to uncertainty and adversity. 
An entrepreneur must be able to make relevant changes and act quickly during unexpected situations.  
 

5.13 Do not be egoistic: Keeping one’s ego under control when it comes to managing employees, 
building partnerships and taking advice, is important. It is not necessary to impress others every time 
but one must be open to hearing out new suggestions and ideas even if they don’t make sense in the 
first go. 
  

5.14 Strong work ethic: Work ethic is a set of moral principles an entrepreneur uses in their work. 
A strong work ethic helps to produce high-quality work consistently and the output motivates them 
to stay on track. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

A 1 

Skill- Based Activities 

 

I. Understanding My Attitude 

 

• Prepare a list of factors that influence attitude in general and entrepreneurial attitude. 

• Demonstrate and identify your own entrepreneurial attitudes during the following micro lab 
activities like thematic appreciation test. 

• Prepare a short write-up on “who am I”. 
 

II. Brand Building 

 

• Pick a product and suggest how its features can be improved. 

• Discuss in groups about brand names of products and enterprises. 
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Today, all of us are concerned and worried about our future both in terms of a good and luxurious 

lifestyle yet our focus is on healthy lifestyle. And a healthy life is only possible when the air, water, 

food is clean. This precisely means that both health (environment) and wealth are important for us 

and one cannot replace the other. 

On the contrary, if we look at human activities in past, we will get evidences that our activities could 

not ensure that we have both wealth and health. Hence, if the economy grew we compromised on 

our health and if we cared for our health and mended our ways for a healthy tomorrow, there was a 

dip in economic growth. 

So, what is needed is that we maintain a balance between both. If we are able to find viable solutions 

to promote economic growth and ensure that the environment is not compromised meaning our 

health is not negotiated, we will be a Green Economy. 

 

 

Collins’ English Dictionary defines Green 

Economy as Biological economy that is 

concerned with renewable energy, green 

buildings, clean transportation, water, waste 

and land management. 

This would mean that without compromising 

on the ecological aspects we create options 

that promote the economy. According to UNEP 

(United Nations Environment Program) a green 

economy is defined as low carbon, resource 

efficient and socially inclusive. In a green 

economy, growth in employment and income 

are driven by public and private investment 

into such economic activities, infrastructure and assets that allow reduced carbon emissions and 

pollution, enhanced energy and resource efficiency, and prevention of the loss of biodiversity and 

ecosystem services. These green investments need to be enabled and supported through targeted 

public expenditure, policy reforms and changes in taxation and regulation. The Green Economy 

provides a macro-economic approach to sustainable economic growth with a central focus on 

investments, employment and skills. 

            Class XI                        Green Skills 

6. Introduction 

              2. What is Green Economy? 
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Further, in order to be a Green Economy, we need to be ‘Green users’ or ‘Consumers’. The whole 

purpose of shifting to manufacturing and production of environment friendly products will be futile if 

the consumers do not use these products. Recently, there has been a rising demand of using ‘Eco-

Friendly’ products, ‘Bio-Products’. If we as consumers of products will demand for ‘Eco-Friendly’ and 

‘Bio-Products’, the manufacturers will be forced to supply it to the market. This clearly works on the 

principle of ‘Demand and Supply’. Hence, it will promote ‘Green Economy’. 

 

 

 

There are five basic components of a Green Economy: 

3.1 Renewable Energy: Renewable Energy is 

the energy produced by the renewable sources. 

Today, with the growing need of technology, 

continued supply of electricity is a necessity. To 

meet the demand, we need to promote alternate 

sources of energy such as solar, wind, wave 

energy. Switching to these renewable sources of 

energy will help reduce the catastrophic impact 

on environment and promote the economy to 

flourish. 

3.2 Green Buildings: Buildings that do not 

impact the environment adversely during the 

construction and use renewable energy, reduce wastage of natural resources such as water 

and manage their waste effectively are called Green Buildings. Today, there is a rising need of 

self-sustained green buildings. Promoting green buildings will not only help preserve the 

resources for future generation but will also help in economic growth. 

3.3 Green Transport: With the 

advancement in technology, there are 

now alternates to conventional 

transportation that used to run on 

petrol or diesel. It is not long ago, that 

the government in India promoted 

Compressed Natural Gas (CNG) to run 

the vehicles. Introduction of Electric 

Vehicles and public transport that run 

on electricity is playing a major role in 

furthering the sustainable 

development. These are not only contributing in preserving the air but also ensure that 

economy is expanding.  

              3. Components of Green Economy  
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3.4 Water Management: The recent crisis in the city of Cape Town, popularly known as ‘Day-

Zero’ is an alarming situation in many metropolitans across the globe. The drought like 

situation has given not only given blow to the world but has affected the economy also. The 

only possible solution to this problem is to reduce the wastage of water and replenish the 

ground water levels by adopting Rain Water Harvesting Systems (RWHS) in our communities. 

This will ensure to have a society that is self-sustainable for its basic water requirement. 

3.5 Waste Management: Any kind of waste will contribute in causing air, water and land 

pollution. This also adds to wastage of resources. Our craving to buy new and discard old, even 

if it is usable is resulting in environmental degradation. Hence, it is pertinent for us to follow 

4 Rs’ and 1 U– REFUSE, REDUCE, REUSE, RECYCLE and UPCYCLE. We must incorporate to 

segregate our waste at source. The basic segregation of wet waste (biodegradable waste) and 

dry waste (all other kind of waste) in our houses and workplaces will help recycle the used 

products. The wet waste can be composted and used in the gardens while the dry waste may 

be either recycled or upcycled. 

 

 

 

Environmental degradation and ecological imbalance is a much talked about issue in the country 

these days. To address these concerns Government of India has promoted and initiated number 

of policies to promote sustainable development. We are going to read few of these policies: 

4.1 WILDLIFE PROTECTION ACT, 1972 - The Wildlife Protection Act, 1972 is an Act of 

the Parliament of India enacted for protection of plants and animal species. Before 1972, 

India had only five designated national parks. Among other reforms, the Act established 

schedules of protected plant and animal species; hunting or harvesting these species was 

largely outlawed. The Act provides for the protection of wild animals, birds and plants; 

and for matters connected there with or ancillary or incidental thereto. It extends to the 

whole of India, except the State of Jammu and Kashmir which has its own wildlife act. 

4.2THE WATER PREVENTION AND CONTROL OF POLLUTION ACT, 1974, amended 

1988 - Water (Prevention & Control of Pollution) Act, 1974 is a comprehensive legislation 

that regulates agencies responsible for checking on water pollution and ambit of pollution 

control boards both at the centre and states. The Water (Prevention & Control of 

Pollution) Act, 1974 was adopted by the Indian parliament with the aim of prevention and 

control of Water Pollution in India. The act was amended in 1988 to clarify the ambiguities 

and to vest more powers in Pollution Control Board. 

4.3 ESTABLISHMENT OF CENTRAL POLLUTION CONTROL BOARD - The Central Pollution 

Control Board (CPCB) of India is a statutory organisation under the Ministry of 

Environment, Forest and Climate Change (Mo.E.F.C). It was established in 1974 under the 

Water (Prevention and Control of pollution) Act, 1974. The CPCB is also entrusted with the 

powers and functions under the Air (Prevention and Control of Pollution) Act, 1981. It 

              4. Policy Initiatives for Green Economy in India 
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serves as a field formation and also provides technical services to the Ministry of 

Environment and Forests under the provisions of the Environment (Protection) Act, 1986. 

It Co-ordinates the activities of the State Pollution Control Boards by providing technical 

assistance and guidance and also resolves disputes among them. It is the apex 

organisation in country in the field of pollution control, as a technical wing of MoEFC. The 

board is led by its Chairperson, who is generally a career civil servant from the Indian 

Administrative Service appointed by the Appointments Committee of the Cabinet of 

the Government of India. 

4.4 THE TERRITORIAL WATERS, CONTINENTAL SHELF, EXCLUSIVE ECONOMIC ZONE 

AND OTHER MARITIME ZONES ACT, 1976 -   It is an Act to provide for the regulation 

of fishing by foreign vessels in certain maritime zones of India and for matters connected 

therewith. 

4.5 FOREST CONSERVATION ACT, 1980 - The Forest (Conservation) Act, 1980 an Act of 

the Parliament of India to provide for the conservation of forests and for matters 

connected therewith or ancillary or incidental thereto. It was further amended in 

1988.[1] This law extends to the whole of India. It was enacted by Parliament of India to 

control further deforestation of Forest Areas in India. The act came into force on 25 

October 1980. 

4.6 ENVIRONMENT PROTECTION ACT, 1986 - Environment Protection Act, 1986 is 

an Act of the Parliament of India. In the wake of the Bhopal Tragedy, the Government of 

India enacted the Environment Protection Act of 1986 under Article 253 of the 

Constitution. Passed in March 1986, it came into force on 19 November 1986. The purpose 

of the Act is to implement the decisions of the United Nations Conference on the Human 

Environment. They relate to the protection and improvement of the human environment 

and the prevention of hazards to human beings, other living creatures, plants and 

property. The Act is an “umbrella” legislation designed to provide a framework for central 

government coordination of the activities of various central and state authorities 

established under previous laws, such as the Water Act and the Air Act. 

4.7 NATIONAL FOREST POLICY, 1988 - The principal aim of National Forest Policy, 1988 is 

to ensure environmental stability and maintenance of ecological balance including 

atmospheric equilibrium which is vital for sustenance of all life forms, human, animal and 

plant. 

4.8 THE NATIONAL ENVIRONMENT TRIBUNAL ACT, 1995 – In 1995, the Central 

Government established the National Environment Tribunal (throught the National 

Environmental Tribunal Act 1995) to provide for strict liability for damage arising out of 

accidents caused from the handling of hazardous substances. 

4.9 NATIONAL GREEN TRIBUNAL ACT, 2010 – The National Green Tribunal has been 

established on 18.10.2010 under the National Green Tribunal Act 2010 for effective and 

expeditious disposal of cases relating to environmental protection and conservation of 

forests and other natural resources including enforcement of any legal right relating to 

https://en.wikipedia.org/wiki/Forest_Conservation_Act,_1980#cite_note-1
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environment and giving relief and compensation for damages to person and property and 

for matters connected therewith or incidental thereto. It is a specialized body equipped 

with the necessary expertise to handle environmental disputes involving multi-disciplinary 

issues. The tribunal’s dedicated jurisdiction in environmental matters shall provide speedy 

environmental justice and help reduce the burden of litigation in the higher courts. 

4.10 BIOLOGICAL DIVERSITY ACT, 2002 – The convention on Biological Diversity (CBD) 

was inspired by the world community’s growing commitment to sustainable 

development. It represented a step forward in the conservation of biological diversity, the 

sustainable use of its components, and the fair and equitable sharing of benefits arising 

from the use of genetic resources. In pursuance to the convention on Biological Diversity 

(CBD), to which it was a signatory, India enacted the Biological Diversity Act in 2002 

following a widespread consultative process over a period of eight years. The Biological 

Diversity Rules were notified thereafter in 2004. 

4.11 NATIONAL WATER POLICY - National Water Policy is formulated by the Ministry of 

Water Resources of the Government of India to govern the planning and development of 

water resources and their optimum utilization. The first National Water Policy was 

adopted in September, 1987. It was reviewed and updated in 2002 and later in 2012. 

 

 

 

 

 

 

A stakeholder in an economy is someone who has the ability to affect or be affected by the growth 

or fall of the economy. Hence, in a Green Economy, the Government (the policy maker), the 

private agencies (business that will either contribute to build the green economy or get affected 

because of change in policies), the people (who will be affected) are the stakeholders at large. 

5.1 Government: In any economy government has the key role. Similarly, in green economy 

also, it is the force with which the government of a nation pushes the need of greening 

the economy. All units of the government are involved in one or the other way in planning, 

budgeting and execution of the policies. In context of our country where we have 

government at multiple levels, involvement at every level is important and hence, 

whether it is central or state government or municipal corporations, all are stakeholders. 

Some major branches of the government – Ministry of Finance, Ministry of Petroleum, 

Ministry of Environment and Forest, HRD Ministry, Education Department, Ministry of 

Health and wellness, Ministry of Tourism, Ministry of Transportation etc. have major 

contribution in defining the green economy of the country or state. 

                 5. Stakeholders in Green Economy and Their Role 

 

Prepare a presentation on important initiatives taken in India for promoting green economy giving brief of 

how these policies have helped protect environment and suggest changes that may be incorporated 

keeping in view prevailing situation of environment degradation. 
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It is because of the efforts of the government that today in our country a lot of initiatives 

such as ban on polythene, Clean Indian, Green India Campaigns, Cleaning of rivers, 

sensitization programmes across the schools in the country are paving way for the young 

generation to contribute in creating Clean and Green Environment. 

5.2 The Private Agencies: Private agencies have a crucial role in giving shape to the policies. 

If the policies are designed but the private agencies fail to execute them as planned, it will 

have a deep impact on the economy. It is the private agencies that plays dual role. These 

are the once who give shape to the policies but they are also the ones who are affected 

with every small change. No economy can blossom without the engagement of the private 

agencies. Private agencies in every field – education, health care, food production, 

transportation, construction, tourism, agriculture etc. enables the policies to reach to the 

public. The public derives benefits only when private agencies perform their role properly. 

Private agencies generate revenue; create employment options through transparent and 

accountable taxation. The private sector has the potential for innovation and develops 

solution for urban cities. The private and public partnership is the driving force to create 

promising Green Economy. 

The areas where the government is not able to lay emphasis or provide a solution, private 

agencies come in play. Sectors of a sustainable society such as waste management 

including e-waste management, promoting organic farming, creating opportunities of 

employment in waste management and laying the way for young entrepreneurs etc. are 

a few to name that are taken care by various private agencies including NGO’s 

5.3 The People: The last but the most important stakeholder in a green economy is the 

people of the nation. Any economy exists because of its people. Government brings many 

policies but the success of the policy depends on how the people have adopted the 

change. If the policy affects the people negatively, it is bound to collapse. Hence, while 

laying down the policy, it is pertinent for the government to keep in mind the 

demographics and the interest of its people. The factor like education of the people of a 

nation also plays a pivotal role in peoples’ collaboration. If the masses are not educated 

and aware about the latest trends and needs, they will either reject the policies or would 

not be able to contribute to the extent to bring a desirable change. 

 

 

 

 

 

 

 

 

Prepare a poster on Green Sectors/ Areas: cities, buildings, tourism, industry, transport, renewable energy, 

waste management, agriculture, water, forests and fisheries. 
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